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Modelamiento de los patrones de vuelo de los murciélagos por medio de la
localizacion acustica

RESUMEN

Los murciélagos navegan en la oscuridad utilizando la ecolocalizacion. Estos organismos
emiten sonidos y utilizan la distribucién de frecuencias sonoras para determinar la posicion de los
objetos. Esta actividad permite detectar su presencia y trazar vuelos, proporcionando informacion
valiosa sobre su comportamiento. A través de un conjunto de micr6fonos, se grabaron murciélagos en
vuelo. Diferencias en el tiempo de llegada a cada micr6fono fueron estimadas para determinar la
posicién espacial de a través del tiempo. Luego, se generaron modelos tridimensionales para explorar
patrones de ubicacién. En general, se encontr6 una relacion entre el patron de llamada y el estilo de
vuelo (vuelos rectos y frecuencias constantes). Estos hallazgos sugieren avances importantes para la

identificacién de patrones de vuelo y por tanto manejo y conservacién de poblaciones de murciélagos.

Palabras clave: 3D, comportamiento animal, ecolocalizacién, micr6fonos, modelamiento 3D,
patrones de vuelo, TDOA.
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Modeling flight patterns of bats through acoustic localization

ABSTRACT

Bats navigate in the dark using echolocation. They emit sounds and use the echo to determine the
position of objects in their environment. This allows us to detect their presence, and track their flights,
providing valuable information about their behavior. We used a microphone array to record bats in
flight. Using differences in time of arrival at each microphone, we estimated the position of the bats in
space and joined them in time to create three-dimensional models of the flights. We then compared
them to the owner's call pattern. We found a relationship between call patterns and flight style. These

findings may have important implications for the conservation and management of bat populations.

Keywords: 3D animation, behavior, echolocation, flight patterns, microphones, TDOA
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CAPITULO |

Introduccion

Los murciélagos son mamiferos voladores conocidos por su habilidad para navegar y
cazar en la oscuridad utilizando la ecolocalizacion. Estos organismos emiten pulsos de sonido
de alta frecuencia y luego interpretan los ecos que regresan para obtener informacion sobre su
entorno; permitiendo asi generar ecolocalizacion (interpretacion de la relacion entre el
posicionamiento del murciélago y objectos en el entorno a través del andlisis de los ecos de
ondas ultrasonicas). Uno de las teorias sobre como funciona la ecolocalizacion en los
murciélagos se basa en que se interpreta las diferencias de tiempo en la llegada de los ecos

para crear este mapa mental de su entorno (Kalko et al., 2008).
1.1Ecolocalizacién

La mayoria de los animales producen sonidos y perciben su medio a través también de
sonidos. En general, las llamadas son esenciales para la comunicacién, deteccion y
clasificacion de predadores y presas como asi también, localizacién de otras fuentes de sonido
y orientacion relativa al entorno (Simmons, 2014). Los murciélagos han evolucionado para
usar el sonido como su principal sentido, detectando y analizando los ecos de sus Ilamadas
con informacién del medio (ecolocalizacién) (Zamrodah, 2016).

Es posible caracterizar la ecolocalizacion de los murciélagos a traves de cinco
variables: duracion, espaciado, intensidad, frecuencia y armonicos (Jones & Rayner, 1988).
En vista de que distintas especies de murciélagos modifican en diferente forma las variables
de ecolocalizacion, segun su entorno y la ubicacion de su presa, dichas variaciones se pueden
utilizar para la identificacion de especies (Jones & Rayner, 1988), Esta informacion es
relevante para los estudios relacionados con ecologia aplicada a la conservacion, debido a la

facilidad con la que se puede utilizar los sensores de sonido para monitorear la actividad,
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forrajeo y uso de habitat (Saldafia, 2011). Usando multiples grabaciones de un mismo
individuo por diferentes microfonos distribuidos en un espacio conocido, es posible trazar sus
actividades (Naus, 2016), permitiéndonos recopilar datos esenciales para la proteccion y

conservacion de estas especies y sus habitats.
1.2 Método Pasivo TDOA / Time difference of arrival - *'Diferencia de

Tiempo de Arribo™ o ""Diferencia de Tiempo de Llegada™

ElI TDOA es una técnica pasiva para localizar y rastrear la emision de sefiales
explorando la diferencia de tiempos de llegada de la sefial con el uso de mdultiples receptores
distribuidos en el espacio (Naus, 2016). Los receptores registran el tiempo de llegada de la
sefal, y a través de calculos de trilateracion o triangulacion, se determina la ubicacién
aproximada de la fuente de sefial. Este proceso se repite continuamente para rastrear el
movimiento de la fuente de sefial a lo largo del tiempo. La precisidén depende de factores
como la exactitud en la medicion de las diferencias de tiempo y la distribucion de los
receptores; por ejemplo, es posible localizar individuos especificos con ayuda de un conjunto
de microfonos, dentro de estudios de comportamiento animal (Kershenbaum et al., 2019). De
tal forma, permite la identificacion de sonidos (Peterson & Kyriakakis, 2005) y facilita el
seguimiento espacial de los animales (Gayk & Mennill, 2020). La localizacion por TDOA
depende de las diferencias en el tiempo en que una sefial llega a diferentes puntos de
referencia (micréfonos) en un area determinada (Fig. 1A). Un sonido radia desde su fuente en
todas direcciones con la misma velocidad (Fig. 1B). Luego, el mismo sonido llega en distintos
momentos a los micréfonos y estas son las diferencias en tiempo desde que se detecta la sefial
por primera vez se puede calcular (Fig. 1C). Conociendo la temperatura del aire, estos
tiempos pueden ser traducidos en radios (distancia recorrida por el sonido después de ser

detectado por primera vez) y se calcula esferas desde cada receptor. Finalmente, el algoritmo
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TDOA estima la esfera tangente a todas las esferas calculados de los microfonos y se calcula

su centroide (Fig. 1D). Este punto es el estimado fuente del sonido (Siddons, 2022).
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Figura 1 Diagrama esquematico general de como localizar una fuente utilizando time difference of arrival

(TDOA)

(A) Presenta el organismo de estudio (asterisco rojo) y los receptores de busqueda del organismo (micréfonos)
(B) Sonido producido por el animal radia hacia los receptores. Los receptores (micréfonos) reciben la sefial en
diferentes momentos.
(C) Calculo de la diferencia del tiempo de llegada de la sefial a cada receptor.
(D) Estimacion de punto de origen. La distancia es calculada por la velocidad de sefial (ej. velocidad de sonido
en aire (20 °C) ~343 m/s) sobre la diferencia en tiempo de llegada al receptor. El receptor mas cerca de sefial
marca tiempo cero. Este es el pinche TDOA (difference in arrival time). Estas distancias son los radios de esferas
desde los microfonos, y se usa un algoritmo para estimar una esfera que es exteriormente tangente a todas estas
esferas (resultantes de los micréfonos). El centro de esta esfera tangente es el punto estimado de origen.
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1.3 Avances del TDOA en relacion a los métodos convencionales del

muestreo de murciélagos

El método més conocido para el monitoreo de murciélagos es la captura y recaptura
con redes de niebla. Las redes de niebla permiten inspeccionar individuos para identificar
familias y especies, ya que se dispone de ejemplares en la mano, ademas de obtener datos
adicionales en cuanto a su morfometria, estado de reproduccion y dindmicas poblacionales
(Bracamonte, 2018). Sin embargo, su manejo requiere destreza, experiencia y mayor
conocimiento del investigador sobre los habitats frecuentados, habitos y horarios de actividad
de las especies. Ademas, las redes de niebla no suelen tener una vida prolongada ya que, al
trabajar con murciélagos, son destruirlas en poco tiempo. La captura también significa alto
niveles de estrés por el animal y podria afectar su comportamiento natural (Costa & Bianconi,
1994).

Dentro de este marco, el estudio de los sonidos producidos por los seres vivos (la
bioacustica) implica el analisis y la interpretacion de los sonidos que emiten para la
ecolocalizacion (el caso los murciélagos) y la comunicacion (Caycedo-Rosales et al., 2013),
registrando la presencia/ausencia de individuos (abundancia) e identificando las especies
(Hintze et al., 2021). Dado que muchos animales presentan vocalizaciones, la bioacustica
puede mejorar via TDOA, ya que permite a los investigadores no solo registrar, pero también

calcular el origen de los sonidos y localizar asi al animal en cuestion. (Hintze et al., 2021).

1.4El Tiempo de llegada (TDOA) y Ecologia

El TDOA como herramienta para el estudio de ecologia es una técnica relativamente
nueva. Por ejemplo, Verreycken et al. (2022) intentaron utilizar la localizacion acustica por
medio de las vocalizaciones emitidas por aves, con micréfonos de calibracion precisa que
identifica la ubicacion de las especies. Durante sus investigaciones crearon un hardware y

software que permite contener un conjunto de micréfonos de cualquier tamafio o forma,
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basado en mas de dos grabaciones. Kershenbaum et al. (2019) trabajaron con un grupo dificil
de estudiar como son los lobos y usaron diferencias en el tiempo de llegada de las
vocalizaciones de aullidos a multiples grabadoras (multilateracién), sincronizadas via GPS
para registrar los diferentes aullidos y, de esa manera estimar el nimero y ubicacién de
manadas. Otra investigacion, realizada en Japdn por Fujioka et al., (2014), utilizaba varias
matrices de 32 micr6fonos en forma de “T” para modelar el vuelo de murciélagos Pipistrellus
abramus; los individuos fueron rastreados durante la caza de insectos en un entorno natural y
se estimd la direccion de llegada para reconstruir el vuelo. Sin embargo, hay pocos estudios
que verifican la precisién de las estimaciones de la ubicacion, cuales pueden diferir
marcadamente dependiendo del disefio del algoritmo, de la sefial y de los ruidos de fondo, en

otros factores (Urazghildiiev & Clark, 2013).

1.5 Patrones de vuelo y su comportamiento

La ecolocacion de los murciélagos es una habilidad para emitir sonidos de alta
frecuencia, los cuales rebotan en los objetos del entorno y estos ecos son interpretados por el
murciélago (Surlykke & Kalko, 2008). Esta informacion les permite navegar y usar el medio
(ejm., cazar) en ambientes oscuros. Segun Schnitzler & Kalko, (2001), los murciélagos
puedan detectar y clasificar los objetos en su entorno y determinar su distancia; por tanto la
ecolocalizacion se vincula directamente con ajustes de vuelo que les permite ajustarse al
medio (ej. evitar obstaculos y forrajeo).

Diferentes especies de murciélagos tienen distintas frecuencias para detectar sus presas
(Surlykke & Kalko, 2008). Por ejemplo, especies que cazan insectos posados en zonas de
follaje tienen llamadas con altas cambios o modulaciones de frecuencia (FM) que varian en
secuencias rapidas (Kalko et al., 2008). Estas variaciones rapidas de FM proporcionan una
imagen de alta definicion del medio donde pueden distinguir insectos posados en troncos y

hojas (Kalko et al., 2008). Por otra parte, murcielagos que cazan en areas abiertas no
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requieren mayor detalle sobre su entorno sin obstaculos; sin embargo, requieren una mayor
area de deteccion. Ellos utilizan frecuencias mas bajos y constantes (Frecuencia constante,
CF) que atentan menos rapidos y que alcanzan distancias mayores (Kalko et al., 2008).
Ellos pasan a frecuencias mas moduladas para mayor precision en la Gltima fase de cazar
(Kalko et al., 2008).

El habitat influye sobre el patron de vuelo, tipo de llamada y su comportamiento
(Kalko et al., 2008). Dentro del monitoreo bioacustico para los murciélagos, es posible
reconocer tres principales tipos de hébitat (Kalko et al., 2008): (1) espacio abierto, con una
menor presencia relativa de obstaculos, suelo descubierto o sobre el agua; (2) borde espacio
cercano, lineas de cambio en la vegetacion o entre habitats, no incluye dentro de la vegetacion
y (3) espacio estrecho dentro de la vegetacion, principalmente cercanos al &rea nucleo de

habitat con vegetacion desarrollada (Fig. 2).

m=-

@D

open space

100

Fuente: (Kalko et al., 2008)

Figura 2 Uso del habitat y tipos de llamadas asociadas. 1, espacio abierto; 2, espacio de borde; 3, espacio
estrecho. Las Ilamadas tipicas de ecolocalizacion se representan como sonogramas (frecuencia versus tiempo) y

sefial de tiempo.
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En los espacios abiertos, los murciélagos pueden emplear un patron de vuelo méas
simple debido a la falta de obstaculos; sin embargo este conlleve menor densidad de presas
(Kunz, 1982). Por ende, se requieren llamadas de mayor alcance. Su ecolocacién es de baja
frecuencia (20-30 kHz) y relativamente constante, que resulta en una mejor adaptacion al
medio (Kunz, 1982; Simmons et al., 1998)). Los bordes de habitat generalmente son lugares
con mayor actividad de los murciélagos (Kalko et al., 2008) ya que a menudo hay una mayor
diversidad de recursos disponibles (Kalko et al., 2008). Los murciélagos utilizan este espacio
para forrajear. El patrén de vuelo de los murciélagos en estas zonas se genera en zigzag
alrededor del borde del habitat, escaneando su entorno (Kalko et al., 2008). En adicion,
algunos murciélagos pueden utilizar el borde del h&bitat como habitats temporales para
dispersarse previo al encuentro con predadores (Kalko et al., 2008). En este sentido, surgen
diferentes estrategias de ecolocacion segun las condiciones y los recursos disponibles (Kalko
et al., 2008). Por ejemplo, pueden cambiar la intensidad de los sonidos emitidos segln sea
necesario y puede variar dependiendo de la especie y su comportamiento de caza (Patriquin &
Barclay, 2003). Finalmente, en los habitats cerrados y espacios estrechos, los murciélagos
estan obligados a tener un patrén de vuelo &gil con mayor capacidad de maniobrar (Kalko et
al., 2008). Los murciélagos se ajustan la frecuencia y la intensidad de sus llamadas para
generar un mayor detalle del medio (Medellin et al., 2000). Ademas, pueden modificar la
duracién y el ritmo de los pulsos para adaptarse a las condiciones especificas de los espacios
estrechos (Medellin et al., 2000).

La presente tesis propone utilizar grabaciones de llamadas de ecolocalizacion de
murciélagos por multiples micréfonos para visualizar trayectos de vuelo de murciélagos. A
través de la técnica de TDOA se localizaron espacialmente a los individuos tiempos
especificos y unificarlos en un trazo de vuelo estimado (via modelizacién en 3D). Ademas,

esto permitira caracterizar la variacion de los patrones de vuelos y los relaciones entre
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Ilamadas de distintas formas de diferentes especies de murciélagos. Finalmente

investigaremos diferencias en patrones de vuelo con y sin redes de niebla.
Pregunta de investigacion

e ;COmo varian los patrones de vuelos de murciélagos con distinto patrones de
Ilamadas?

e ;COmo varian los patrones de vuelos con y sin redes de niebla en el camino?

Objetivo general

e Crear modelos 3D de trayectos de vuelos de murciélagos usando datos recopilados de
una matriz de micréfonos y un algoritmo usando la time difference of arrival (TDOA)

de las llamadas.

Objetivos especificos

e Comparar varios trayectos de vuelo en un espacio aéreo alrededor de un conjunto de
micréfonos cuando una red de niebla esta presente o no.

e Caracterizar patrones de vuelo y relacionarlos con las diferentes llamadas identificadas
(diferentes frecuencias y formas).

e Graficar los trayectos identificados utilizando el algoritmo del TDOA.

e ldentificar llamadas individuales en grabaciones y calcular sus diferencias en tiempo.
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CAPITULO II

Area de Estudio y Metodologia

2.1 Area de Estudio

El estudio se realizé en la localidad de Gordeleg, perteneciente a la parroquia
Zhidmad, Cantén Gualaceo, Provincia de Azuay; a 2667 m s.n.m (UTM WGS84 17S:
732449.85, 9674813.11; 2667 m s.n.m.). (Mapa 1). La precipitacién promedio anual es de
3500 mm, con temperaturas promedio anuales de 26° C. La topografia en el sector es
irregular, con pendientes moderadas y planicies pequefias.

Elegimos esta zona porque la experiencia personal nos demostrd que en ella
abundaban los murciélagos, esta dominada por actividades agricolas de ciclo corto (maiz,
fréjol, arveja) y frutales (duraznos, peras, manzanas). Esta zona ofrece un habitat ideal para
los murciélagos; ademas de fuentes de alimento, hay abundantes estructuras como edificios

abandonados o troncos de arboles para dormideros.



Mapa 1 Ubicacién de la comunidad de Gordeleg y puntos de muestreo
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UBICACION DE LA ZONA DE ESTUDIO

EN LA PARROQUIA ZHIDMAD

7

Leyenda

Puntos de muestreo
Zona de Plaga
Red de Niebla
Red de Niebla
Punto de muestreo 1
Punto de muestreo 2

Punto de muestreo 3

Punto de muestreo 4

Coordinate System: WGS 1984 UTM Zone 17S
Projection: Transverse Mercator

Datum: WGS 1984

False Easting: 500,000.0000

False Northing: 10,000,000.0000

Central Meridian: -81.0000

Scale Factor: 0.9996

Latitude Of Origin: 0.0000

Units: Meter

Fuente Autor
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2.2 Metodologia

2.2.1 Procedimiento

En los meses de julio a diciembre de 2022, empleandose realizaron muestreos
mensuales (dos noches consecutivas por muestreo) a través de tres Song Meter SM3BAT
(Wildlife Acoustics, Song Meter, U.S). Es una grabadora programable para el monitoreo
acustico y ultrasénico a largo plazo de vida silvestre capaz de grabar en mono y estéreo.

En total, se utilizaron un conjunto de cinco micréfonos separados a una distancia
entre si de ~ 0.45 cm. La distancia sobre el suelo estaba en un rango de 60 cm a 80 cm (Fig.
3). Antes de colocar los micréfonos en el conjunto, se calibraron las grabadoras para
minimizar variacion entre los relojes internos de las tres grabadoras y corregir por las

diferencias remanentes (Anexo 7).

Fuente Autor

Figura 3 Conjunto de micrdfonos creado con tres grabadoras sincronizadas
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Durante del monitoreo bioacustico, se usaron dos redes de niebla. Las redes estuvieron
operativas (abiertas) durante 1.5 h, luego de este tiempo las redes fueron retiradas y los
micréfonos siguieron grabando durante otra hora y media. Cada pase de murciélago (una
grabacion continua de un murciélago considerado como un registro) fue identificado dentro
de las grabaciones y se clasificaron los tipos de llamada como asi también se calcularon los
tiempos de llegada (Anexo 4). Utilizando el algoritmo TDOA se estimd el punto de origen en
tres dimensiones (X, y, z); para el efecto, se us6 como referencia las coordinadas de cada
micréfono en conjunto con las diferencias de tiempo de llegada. EI TDOA usa las diferencias
en tiempo para generar distancias recorrido por el sonido después de que se detecta por
primera vez (por el micréfono mas cercano a la fuente) (Siddons, 2022). Estas distancias son
incorporadas en un matriz para generar una reduccion Gaussiana (Anexo 6). Esta reduccion
permite la resolucion de ecuaciones simultaneas permita el calculo de todas las variables
necesarias para calcular la esfera tangente; de tal forma, que el punto central de la esfera
tangente muestra el origen del sonido (Anexo 6). Este procedimiento fue repetido para cada
Ilamada (deteccion) del individuo, y todas las llamadas fueron agrupados en series
temporales. Las series temporales permitieron generan una modelizacion 3D comparando los

diferentes tipos de llamadas con los patrones de vuelo (Anexo 5).
2.2.2 Andlisis de llamadas

1. Extraccion de medidas de llamadas:

En este paso, se procedera a extraer las medidas relevantes de las llamadas de murciélagos
utilizando técnicas automaéticas de deteccion y grabacion. Posteriormente, se calcularé el
promedio de estas medidas para cada pase de murciélago, lo que nos permitira obtener una

vision de las caracteristicas de las llamadas durante sus vuelos.
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2. Analisis de conglomerados para identificar llamadas similares:

Utilizando un andlisis de conglomerados, se agruparan las llamadas de murciélagos
similares en categorias o clusteres. Esto nos ayudara a identificar patrones y similitudes en las
vocalizaciones de los murciélagos, lo que podria indicar la presencia de diferentes especies o

subespecies.
3. Visualizacion con PCA (Analisis de Componentes Principales):

Emplearemos el analisis de componentes principales (PCA) para visualizar las relaciones
y similitudes entre los diferentes grupos de llamadas identificados en el paso anterior. Esto
nos permitira representar graficamente la estructura de las vocalizaciones de los murciélagos

en un espacio multidimensional reducido utilizando PCA.

4. Modelado y clasificacion visual de cada pase por tipo de vuelo:

En este punto, se desarrollara un modelo para clasificar visualmente cada pase de
murciélago en funcion de su tipo de vuelo. La clasificacidn se basara en observaciones
visuales de las grabaciones y puede incluir categorias como vuelo recto, vuelo espiral, vuelo

acrobatico y vuelo lineal

5. Comparacion de frecuencias de morfocantos y patrones de vuelo, prueba de

independencia con Chi-cuadrado (Chi2):

Se realizaré un analisis comparativo de las frecuencias de los diferentes tipos de Ilamadas
identificadas y los patrones de vuelo categorizados en el paso anterior. Para determinar la
independencia entre estas variables, se aplicara una prueba de Chi-cuadrado (Chi2), lo que
nos permitira evaluar si existe una asociacion significativa entre los morfocantos y los

patrones de vuelo.

6. Comparacion de variables entre la presencia y ausencia de red de niebla.
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Finalmente, se llevara a cabo una comparacion de diversas variables (como morfocantos,
patrones de vuelo u otras medidas relevantes) entre los casos en los que se utiliza la red de
niebla y aquellos en los que no se utiliza. Esto ayudara a evaluar si la presencia de esta tiene

algun impacto significativo en las caracteristicas del comportamiento de los murciélagos.
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CAPITULO 11l

RESULTADOS

En total, se realizaron 45 horas de grabaciones con informacion atil para procesar
(Ilamadas y registro de murciélagos); en este intervalo de tiempo se extrajo 29 pases. En cada
audio (en series de 10 minutos) se encontrd una mediana de cuatro Ilamadas. No registramos

capturas de murciélagos durante el periodo cuando las redes fueron abiertos.
3.1Tipos de llamadas

Mediante el calculo de promedios de medidas de cuatro variables acusticas: la Frecuencia
Pico (P_f), la Frecuencia mas baja (L_f), el Tiempo transcurrido desde el inicio del canto
hasta alcanzar la frecuencia pico (Tt) y duracion de la llamada (Ic) y la posterior aplicacion
del analisis de datos, se obtuvieron tres agrupaciones distintas de llamadas (5,6% de variacion

dentro del andlisis de datos).

Utilizamos un analisis de coordenadas principales para visualizar la agrupacién de las
Ilamadas (Fig. 4), se obtuvieron tres agrupaciones distintas. Estos grupos se denominaron
"Morfocantos”, se utilizé dicho término para hacer referencia a los cantos que exhibian

caracteristicas acusticas comunes y que posiblemente pertenecen a diferentes especies.
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Figura 4 PCA para visualizar las distancies entre los cantos y las agrupaciones del andlisis de datos. Las
medidas de los cantos eran: P_f: Peak Frecuency (Frecuencia alta), L_f: Low Frecuency (Frecuencia baja), Tt:

Time to Peak Frequency, Ic (length of call)

3.1.1 Morfocantos

Tres morfocantos (agrupaciones) fueron identificadas (Fig. 4.). Entre los morfocantos
Ay B se observa una similitud en su forma; sin embargo, hay marcadas diferencias en sus
frecuencias mas bajas.

Tabla 1 Promedio y desviacion estandar de las mediciones de las cuatro caracteristicas principales de llamadas
de murciélagos para los tres morfocantos identificados

Tipo Frequencia Baja Frequencia Baja Frequencia Baja Frequencia Baja
(L_f)enkHz (P_f) en kHz (tt) en kHz (Ic) en kHz
A 17.90 = 2.15 31.18 + 2.65 0.01 + 0.01 0.03 = 0.04
C 10.22 + 1.27 18.5 + 2.65 0.02 + 0.01 0.1 + 0.06
B 30.51 + 1.4 40.67 + 1.3 0.02 + 0.01 0.05 = 0.02

Fuente Autor
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El morfocanto A muestra un promedio de longitud de 0.033 ms y una frecuencia pico
de 31.18 kHz (Fig. 5; Tabla 1). Aunque, el morfocanto B también tiene un promedio de
longitud de 0.05 ms; sin embargo, su frecuencia pico alcanza los 40.67 kHz (Fig. 5).
Finalmente, el morfocanto C exhibe una duracion promedio de 0.035 ms y una frecuencia
pico de 18.5 kHz, (Fig. 5). Estas divergencias en las caracteristicas acusticas de los
morfocantos identificados respaldan la nocidn de que corresponden a entidades acusticas

distintas con posibles diferencias taxondémicas
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Fuente Autor

Figura 5 Morfocantos con medidas

3.1.1.1 Morfocantos al respecto de presencia de las redes de niebla.

Graficamos las medidas de los cantos y agrupamos en tipo de llamada y presencia de
redes (Fig. 6). Un andlisis visual muestra que la baja y alta frecuencia de los morfocantos
muestra diferencias entre morfocantos(Fig. 6A; 6B). Ademas, podemos apreciar que
Morfocanto A, que solo se presenta en ausencia de la red, mientras Morfocanto B
exclusivamente parece cuando hay la red (Fig. 6; Tabla. 2). lo que sugiere una asociacion
entre la ausencia de la red y la presencia de un patrén especifico de frecuencias de canto

(Morfocanto A) (Fig. 6)
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Figura 6 Cuatro caracteristicas de las Ilamadas de ecolocalizacion separado en los diferentes tipos de
Morfocantos y presencia o ausencia de redes de niebla: (A) Duracion de llamada, (B) Frecuencia Baja, (C)
Frecuencia Alta (D)Tiempo hasta la Frecuencia Pico. Las cajas rojas fueron grabados con red, mientras que las
cajas azules fueron sin red

Tabla 2 Numero de Morfocantos con y sin presencia de red de niebla

Morfocanto
Red de niebla A B C
Con 1 15 3
Sin 10 0 0

Fuente Autor
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3.2Patrones de Vuelo

Los modelos 3D han permitido visualizar y analizar los cambios de direccién entre
puntos. Por tanto, los puntos estimados para llevar a cabo la construccion de modelos que
describen los vuelos y los cambios de direccion identificaron cuatro patrones de vuelo

distintos: recto,(Fig. 7) zigzag, (Fig. 8) espiral (Fig. 9) y acrobético (Fig. 10).
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o Vuelo recto: Algunos murciélagos vuelan en linea recta con minimas

desviaciones. (Fig. 7)

0.005 0.010 0.015 0.020 0.025 0.030 0.035

Fuente Autor

Figura 7 Modelo 3D mostrando un vuelo recto, calculado de una serie de puntos estimados de TDOA de un
murciélago en vuelo (un pase). Los ejes no son de escala.
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o Vuelo en zigzag: Algunos murciélagos, realizan vuelos en zigzag, este patron

de vuelo les permite maniobrar rapidamente (Fig. 8)

- - B

L

0.025 0.080 0.085

Fuente Autor

Figura 8 Modelo 3D mostrando un vuelo en zigzag, calculado de una serie de puntos estimados de TDOA de un
murciélago en vuelo (un pase). Los ejes no son de escala.
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o Vuelo en espiral: Algunos murciélagos utilizan un vuelo en espiral en una

trayectoria en descendente y ascendente (Fig. 9)

= .

0.005 0.010 0.020 0.025

0.030 0.035

Fuente Autor

Figura 9 Modelo 3D mostrando un vuelo en espiral, calculado de una serie de puntos estimados de TDOA de un
murciélago en vuelo (un pase). Los ejes no son de escala.
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o Vuelo acrobatico: Estos murciélagos pueden realizar maniobras rapidas y

precisas, como giros cerrados, cambios de direccion bruscos y vuelos

invertidos (Fig. 10)
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Figura 10 Modelo 3D mostrando un vuelo acrobético, calculado de una serie de puntos estimados de TDOA de
un murciélago en vuelo (un pase). Los ejes no son de escala.
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3.3Vuelo y Morfocanto

Realizamos una comparacion entre los Morfocantos de llamadas y los patrones de
vuelo (Tabla 1). Encontramos una relacion significativa entre los Morfocantos de llamadas y

los estilos de vuelo (%@, n=29) = 17.597, p < 0.01). (Tabla 3)

Tabla 3 Distribucién de las frecuencias de llamadas entre el tipo de vuelo y el Morfocanto de llamada

Morfocanto de llamada

Tipo de Vuelo A B C
Acrobético 6 4 1
Recto 2 0 2
Espiral 1 10 0
Zigzag 2 1 0

Fuente Autor

Al examinar los residuos del modelo de Chi2, se evidencié que los valores de error
sugieren una asociacion entre el Morfocanto de llamada A y vuelos acrobaticos, mientras que
se observaron mas vuelos en espiral cuando se registraron los Morfocantos B y C, los cuales

estan asociados con vuelos en linea recta
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Tabla 4 Numero de instancias de morfocantos de murciélagos en relacion de tipos de vuelo y presencia y

ausencia de redes de niebla

Morfocanto de llamada

Red de niebla  Tipo de Vuelos A B C
Acrobatico 1 4 1
Recto - - 2

Con Espiral - 10 -
Zigzag - 1 -
Total 1 15 3
Acrobatico 5 - -
Recto 2 - -

Sin Espiral 1 - -
Zigzag 2 - -
Total 10 0

Total General 11 15

Fuente Autor

3.4Morfocanto de canto y presencia de Red de Niebla

Cuando investigamos la relacion entre la frecuencia de observaciones de los diferentes
morfocantos y la presencia y ausencia de redes de niebla observamos que hay una prevalencia
de Morfocanto B cuando la red fue puesto y una ausencia de Morfocanto A cuando la red fue
retirada (Tabla 4). Una prueba de independencia mostraba una relacion significativa entre
estos variables (x%@, n=29) = 24.98, p < 0.001). Esto podria sugerir que estos Morfocantos

podrian ser de la misma especie.

3.5 Pagina web con los Modelos en 3D

Los resultados del modelamiento tridimensional (3D) exhiben secuencias detalladas
de movimiento y comportamiento de los murciélagos. Para facilitar una mejor visualizacion y
accesibilidad, se desarroll6 una pagina web dedicada especificamente a la presentacion de los
patrones de (Fig. 11). Esta plataforma en linea permite la apreciacion detallada y dindmica de

las caracteristicas de vuelo.
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https://caroabipacheco9.wixsite.com/my-site

Figura 11 Codigo QR y link de la pagina web para visualizar los modelos 3D
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CAPITULO V

DISCUSION

TDOA junto con un conjunto de cinco micréfonos es muy prometedor como
herramienta para rastrear y modelar el comportamiento de los murciélagos. La combinacién
de grabacion de alta calidad permite el analisis de Ilamadas individuales y la oportunidad de

explorar vinculos entre las caracteristicas de las Ilamadas y los patrones de vuelo.

Los hallazgos del presenta estudio apunten que los morfocantos Ay B, por su
exclusividad entre las diferentes condiciones (con y sin redes), pueden ser formas diferentes
producidas por una misma especie bajo diferentes condiciones de vuelo (distintos vuelos en
presencia y ausencia de redes). EI morfocanto C parece ser lo suficientemente distinto como

para sugerir que es en una diferente especie (Fig.5).

La plasticidad de las Ilamadas es un fenémeno en el que los murciélagos se adaptan
segun las condiciones locales que apoya el idea que los Morfocantos A y B son del mismo
especie (Kraker & Pérez, 2012). En presencia de redes, las llamadas son registradas a una
frecuencia aproximada de ~30 kHz, mientras que, en su ausencia, la frecuencia registrada es
de ~20 kHz (Fig.5). Dentro de este marco, esta plasticidad encontrada podria explicar como
evitan redes de niebla en areas abiertas debido a una mejor definicion en la ecolocalizacién
(Jung et al., 2014). El cambio en la frecuencia frecuentemente estaria asociado a un ajuste
mas estrecho entre los tiempos de la emisién de las llamadas y la recepcion del eco (Estrada-
Villegas et al., 2018). Por ejemplo, Rhinolophus ferrumequinum comprime las ondas de
sonido, aumentando la frecuencia percibida, al alejarse del obstaculo, el tiempo entre emision
y eco se alarga, expandiendo las ondas y reduciendo la frecuencia percibida (Jones et al.,

2009). La identificacion de murciélagos por sus llamadas puede incluir la frecuencia



Pacheco Rodas 36

dominante, el ancho de banda, la modulacion y la duracion de los llamados (Jones et al.,
2009), al incluir informacion sobre el vuelo podria mejorar la identificacién de especies,

tomando en cuenta la variaciones de las llamadas asociados con estos..

Los vuelos rectos (Tabla. 4) solo se presentaron con Morfocanto C, la Ilamada CF;
mientras que el vuelo en espiral, se presento principalmente con Morfocanto B. Sin embargo,
mayores son esfuerzos son necesarios, en especial al desarrollar modelizacion 3D que permita
relacionar (via inferencia estadistica) los trazados de los vuelos y la presencia / ausencia de las
redes de niebla. El algoritmo TDOA ha demostrado ser una potencial herramienta
complementaria para el monitoreo de murciélagos. Sin embargo, una depuracién de la
metodologia para corregir problemas en la sincronizacion de cronémetros es necesarios. Por
ejemplo, a pesar de corregir diferencias medidas en los relojes, las distancias estimadas de los

puntos no fueron realistas.

La determinacion de los patrones de vuelo es informacidn necesaria en estudios de
ecologia (Lopez-Bosch et al., 2022). Reconocer los patrones de vuelo permite a los
investigadores asegurar el conocimiento sobre como los organismos usan el habitat y, como
este uso puede verse influenciado por alteraciones antrépicas. Por ejemplo, en habitat
alterados, las especies gastarian mas energia para el forrajeo, esto implicaria una reduccién
del fitness (Lopez-Bosch et al., 2022), un indicador de estos fendmenos pueden ser las
variaciones de los patrones de vuelo (en tiempo y espacio) de poblaciones en diferentes
niveles de alteracion de habitat. Dentro de este marco, Lopez-Bosch et al. (2022) identificaron
cémo la afinidad al hébitat influye en la sensibilidad de los murciélagos a la fragmentacion;
utilizando el monitoreo acustico detectaron las llamadas de los murciélagos y evaluaron la
presencia y ausencia de individuos a través de diferentes niveles de fragmentacion del habitat.

De todas formas, el monitoreo acustico puede convertirse en una herramienta valiosa para
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futuras investigaciones, permitiendo obtener una comprensién mas completa y dindmica de

las relaciones especie y habitat.
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ANEXOS

Anexo 1 Panoramica de la zona de estudio

. ﬂ‘ - ~

Fuente: Autor
Anexo 2 Estructuras e instalacion del equipo

Fuente: Autor
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Anexo 3 Colocacion del instrumento en la zona de estudio

Fuente: Autor
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Anexo 4 Proceso Avisoft

Unidn: En esta fase unificamos las grabaciones de las tres maquinas File > Open: se
escoge el archivo de una maquina, se abrira una ventana con un oscilograma y un
espectrograma (Figura 7), para afiadir otro audio File > Specials > Add channel(s)
from file y asi para el siguiente audio.

Guardamos el audio unido File > Save As lo guardamos en formato WAV
Calculamos la diferencia de sonidos por medio del audio de prueba generado por los
micréfonos acusticos, con el dato generado pasamos al siguiente paso

Sincronizacién de sefiales y eliminacion de retardos: Este proceso se realiza con la
opcion "shift" en File > Specials > Shift channels ayudandonos a utilizar para alinear
los cantos, lo que permite una mayor precision en el analisis. (Figura 4), el programa
genera una precision automatica por la opcion “Calculate shifts autimatically using
CCF”

Shift / Align Channels x
Align channels
] apply IR filker Setup...
Cancel
[ ] apply FIF Filker Setup...
Help...

[ ] use DIO tracks rather than waveforms

frequency range: - kHz

Calculate zhifts automatically usig CCF

Time zhift channels

App!
s 0] PRI

channel 2 |-+ |0.001078 (= [275]

channel 1 |-+
R ezet
channel 3 |-+ |0.020301 (= [B197]
channel 4 |4 (0020018 [z [B16E]
channel & |-+ | |0.01702 [z [4357)

HELH

Figura Parametros del Shift

Antes de iniciar el analisis es necesario configurar los parametros del analisis del
TDOA en Analize > Specials > Time — delay — of — arrival measurements (TDOA)
> TDOA Settings.
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- En el mend TDOA Settings configuramos los siguientes parametros (Figura 5). Al

pulsar OK, el TDOA saldré con las caracteristicas establecidas

TDOA Settings >
output options
tirme: stamp
[ ] duration Eiee]
[ ] amplitudes Help...
[ ]label

frequency range:; - kHz

Take pozitive CCF masinmum anly

Figura Configuracion de parametros del TDOA

- Una vez localizada visualmente una region que contiene una Illamada, se hace clic
derecho en el area y se crea una etiqueta con la opcion Insert section label from
marker, extraemos el canto para realizar el analisis en Tools > Labels > Save
Labeled sections into a single. WAV file

- Extraido la llamada, posteriormente se selecciona cada canto y se coloca una etiqueta,

terminado el proceso se analiza el TDOA (Figura 6)

Figura Extraccion de los cantos en una llamada
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- Para el analisis del TDOA nos ubicamos en Analize > Specials > Time — delay — of —
arrival measurements (TDOA) > Copy multiple TDOA’s from section labels, esta
opcion copia los datos obtenidos de la diferencia de tiempo de llegada y se pegara en

una hoja de calculo.

% 18.03_2023_Audio 5_(2)_shift_empty.way * - Avisoft-SASLab Pro 'DEFAULTINI
File Analyze Edit Tools Actions Metada

®| | m || ra]=2 = | W eifeat | i) =R ) e e 1= 20343
T e A% i
[>]

Help

00:00:02.24 00:00:02.26 00:00:02.28 00:00:02.3 00:00:02.32 00:00:02.34 00:00:02.36 00:00:02.38 00:00:02.4

Pan or Zoom [drag up/dowin]

Figura Vista del oscilograma (arriba) y sonograma (abajo) de una Ilamada en el programa
Avisoft SASLab Pro
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Anexo 5 Pasos realizados para la animacion en 3D

1. Preparacion de datos:

o Obtén los registros de tiempo de llegada (Time of Arrival, TOA) de las sefiales
de diferentes sensores o estaciones.

o Organizamos los datos en un formato adecuado, como un dataframe o matriz,
donde cada fila representa una observacién y cada columna representa el

tiempo y los micréfonos.
2. Calcular las diferencias de tiempo:

o Utiliza los registros de TOA para calcular las diferencias de tiempo entre los

microfonos
3. Estimacién de la posicion:

o Utiliza las diferencias de tiempo y las coordenadas de los sensores o0 estaciones
para estimar la posicién del evento o fuente.

o Existen diferentes algoritmos de estimacion de posicion, como la trilateracion
o la multilateracion, que se pueden utilizar dependiendo de la precision

requerida y las caracteristicas de la sefial.
4. Visualizacion en 3D

o Utilizamos una biblioteca de visualizacion de mapas en RStudio, como
“leaflet” 0 "ggplot2’, para crear un espacio cartesiano proyectado en 3D donde

muestra los micréfonos.
5. Animacién:

o Utiliza la biblioteca de animacioén en RStudio, como “plotly’, para crear la
animacion TDOA.

o Define el intervalo de tiempo para cada cuadro de la animaciéon, que puede ser
igual o proporcional a las diferencias de tiempo calculadas.

o Utiliza una funcién de animacion para iterar a través de los cuadros y

actualizar la posicion del evento en el mapa en cada cuadro.
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o Renderiza y visualiza la animacion en RStudio, ajustando los parametros de

reproduccion segun sea necesario.
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Anexo 6 Logaritmo

Estimar el origen de una sefal en tres dimensiones mediante
receptores pasivos

David C. Siddons

2023-08-08

Contenido
1 PROBLEMATICA iERROR! MARCADOR NO DEFINIDO.

1.1 EJEMPLO SIMPLIFICADO EN 2D jERROR! MARCADOR NO DEFINIDO.
1.2 SoLucioN  {ERROR! MAARCADOR NO DEFINIDO.

2 TEORIA iERROR! MARCADOR NO DEFINIDO.
2.1 MATEMATICAS iERROR! MARCADOR NO DEFINIDO.
2.2 SIMPLIFICANDO EL SISTEMA LINEAL iERROR! MARCADOR NO DEFINIDO.

Problemética

Cuando se recibe una sefial, se puede estimar su procedencia. Por ejemplo, una persona que oye un
pajaro puede juzgar de qué direccion procede la sefial y, si se trata de un sonido conocido, incluso la
distancia a la que se encuentra. Esto se debe a la capacidad de las personas para oir en estéreo, y las
diferencias minimas en los tiempos de llegada a los oidos se traducen automaticamente en una
direccion.

Reproducir este fendmeno con micr6fonos ha resultado ser obstinadamente dificil. Mateméaticamente
requiere varios datos importantes, pero técnicamente faciles de obtener:

« Diferencia de tiempo de llegada entre micréfonos
» Posiciones conocidas de los receptores (micréfonos) en x,y,z

» Velocidad del sonido en las condiciones actuales (temperatura del aire, presion atmosférica,
humedad)

Ejemplo simplificado en 2D

La solucién 3D final a este problema requiere una matriz de cinco micréfonos para resolver la
posicion de una sefial de forma inequivoca. Con cuatro micr6fonos se llega a una solucién cuadratica
que tiene dos posibles respuestas, ambas generalmente plausibles (véase ese hombre). Aqui
presentamos un ejemplo en 2D de cdmo resolver el problema.

Aqui colocamos un conjunto de cuatro micréfonos (a,b,c y d) en la esquina de un cuadrado de 20*20
(Figura

1). Hay que tener en cuenta que el array puede tener casi cualquier disposicion (en la solucién 2D al
menos un punto tiene que ser no lineal con respecto a los demas; en la solucion 3D esto se traduce en
no ser coplanar).

La fuente de sonido es el punto negro. La sefial tarda un tiempo desconocido en llegar al micréfono
mas cercano (el micréfono “a” en este caso). A continuacion, podemos calcular el tiempo adicional
que tarda en llegar a los deméas microfonos: la diferencia en el tiempo de llegada de las sefiales.



Pacheco Rodas 48

207

=207

X

Figure 1: Las lineas rojas muestran los circulos originales, mientras que las lineas grises muestran los
circulos ampliados por r hasta la interseccion de los tres circulos.

En la grabacién, detectamos la sefial en el Micréfono A (tiempo = 0), y en el Micr6fono B 0.032
segundos después, el Micréfono C 0.049 segundos después y el Micr6fono D 0.032 segundos después.
Esto se traduce en distancias, concretamente en los radios de los circulos alrededor de los micréfonos:

Table 1: Coordenadas de los cuatro micréfonos y las diferencias de
tiempo desde un punto (4,16) con los radios calculados asociados

Microphone x-Coord y-Coord Time difference (s) Estimated Radius (m)
A 0 20 0.000 0.000
B 20 20 0.032 10.836
C 20 0 0.049 16.971
D 0 0 0.032 10.836

Una vez calculados estos radios, el ultimo paso es calcular la circunferencia tangente a las cuatro

[P

circunferencias (el microfono “a” es una esfera de radio 0, es decir, un punto) (Figura 2).
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Figure 2: El objetivo del problema de Appolonius es encontrar las circunferencias que son interna y
externamente tangentes a las tres circunferencias

Solucion

En realidad, se trata de un problema muy conocido, postulado por primera vez por Apolonio para tres
circulos. En realidad, hay dos soluciones posibles, un circulo que es tangente internamente a los tres y
un circulo que es tangente externamente.

Sin embargo, es de suponer que esto perdera precision a medida que nos movamos en el plano z (no se
muestra, porque aun no lo he hecho). Por lo tanto, tenemos que desarrollar esto en 3D.

Teoria

Resulta que esto es una ligera variacion del problema de “Circulos de Apolonio”:
Dados tres circulos y un circulo que es tangente a los tres. Una circunferencia puede ser
internamente tangente o externamente tangente a una de las circunferencias dadas (Figura
2). Este problema puede generalizarse al problema d-dimensional de encontrar la
hiperesfera tangente a d + 1 hiperesferas dadas.

En este caso se trata de encontrar la circunferencia que toca el exterior de las tres circunferencias, ya
sea interna o externamente, en nuestro caso solo requerimos el célculo interno.

Matematicas
Primero identificamos las ecuaciones de las cinco esferas en cuestion. Como s6lo necesitamos la
esfera tangente interna, podemos utilizar sélo r positivo. El negativo nos dard la esfera tangente
exterior.

(X =x1)*+ (Y- y1)*+ (2 - 21)*=(r - nn)?

(X=X’ + (Y = y2)*+ (2 - 22)* = (r - o)’

(1)
2)
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(x=x3)*+ (y—y3)’+(z-23)°=(r—r3)° 3)
(x=xa)*+ (y —ya)’ + (2= 23)*= (r - ra)’ 4)
(= x)+ (y = ys)'+ (2= 25 = (r = 15)? ®)
A continuacion, expandimos las ecuaciones:
OA+ Y2+ 2%) + (Pt y2 + 20 - Qxax + 2yay + 2202) = P+ -2 (6)
O+ Yy + 25 + (Xt y?P + 22%) = (2xx + 20y + 2252) = P+ 1= 2ror (7)
O+ Y2+ 22) + (5 + y3? + 23%) = (Qxax + 2ysy + 2232) = r*+ 13- 2r3r (8)
O+ Y2+ 2%) + (Pt ya® + 24%) = (2xaX + 2yay + 2242) = r*+ ra>= 2rar )
O+ Y2+ 2%) + (X5 + ys2 + zs?) — (2xsx + 2ysy + 2252) = r*+ rs?= 2rsr (10)

Para eliminar los términos cuadréaticos de x; y; z y r, las ecuaciones (7), (8), (9) y (10) se restan de
ecuacion (6) dando las cuatro ecuaciones siguientes:

(1 + yi2+ 21%) = (0 + v2? + 25%) = (2xax + 21y + 2212) + (2xox + 2y2y + 2222) = ri-r2?= 2rir + 2rpr (11)
(1 + yi2+ 21%) = (s + y3° + 23%) — (2xax + 2y1y + 2212) + (2x3x + 2y3y + 2232) = ri®=r3?= 2rir + 2r3r (12)
O+ yi2 + 20%) = (XPa+ ya? + 24%) — (2xax + 2y1y + 2212) + (2xax + 2yay + 2242) = ri2-ra?= 2rir + 2rar (13)
(1t yi? + 20%) = (%5 + ys? + z5%) — (2xax + 2y1y + 2212) + (2xsx + 2ysy + 2252) = ri?-rs?= 2rir + 2rsr (14)
Que a su vez se puede reordenar para colocar todos los valores conocidos en el lado derecho y

simplificado:

(2x2= 2x1)x + (2y2- 2y1)y + (222- 221)z + (2r2- 2r1)r = (x5 + yo? + 2°) = (X*1 + yi? + 24) + ri®- r2 (15)
(2x3= 2x1)x + (2y3- 2y1)y + (223- 221)z + (2r3= 2r1)r = (x%3 + y3 + z32) = (X1 + y12 + z:2) + n?- r:2(16)
(2xa= 2x1)x + (2ya= 2y1)y + (224— 221)z + (2rs— 2r1)r = (X4 + ya® + 242) — (X1 + yi? + 24%) + ri®= r2 (17)

(2X5— 2X1)X + (2y5— 2y1)y + (225— 221)2 + (2r5— 2I’1)I’ = (X25 + y52 + 252) - (X21 + y12 + 212) + f12— I’sz (18)
esto produce un sistema de cuatro ecuaciones lineales con 15 coeficientes:

aux + a2y + 013z + awar = b1(19) a21x + a22y + @23z + G2ar = b2
(20) a31x + az2y + @33z + azar = b3 (21) @aix + aa2y + qa3z

+ gaar = ba (22)

donde:



ain = 2Xiv1— 2X1 Q2 = 2yis1— 2y1 Qi3 = 2Zis1— 221 Qi

= 2risi— 21 bi =(Xin1 + yi+1 + zia1) — (x12 + y12 +

z12) + ra-rpwparai=1,2,3,4

Simplificando el sistema lineal
En este punto, cuando estamos calculando el TDOA, una vez que hemos calculado las distancias r;
podemos sustituir todos los valores en los coeficientes y utilizar la eliminacion de Gauss para resolver
para x, y, zy r. Esto producira una solucion unica para la fuente del sonido.

11 a2

. 21 Lo
Matriz =

az1  azz

1 Qg2

3
oy
aaz
L]

14
{24
.34
44
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Fuente: (Siddons, 2022)
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Anexo 7 Sincronizacion de los relojes internos de las grabadoras mediante la unién de micr6fonos.

"*Sincronizacion de los relojes internos de las grabadoras mediante la union de los
micréfonos y el uso de un pitido a dos metros con un parlante, lo que ayud6 a eliminar la
diferencia de tiempo™*

En este proceso, se llevara a cabo la sincronizacion de los relojes internos de las grabadoras
mediante la interconexion de los micr6fonos, ademas de utilizar un pitido emitido a una
distancia de dos metros a través de un parlante. Esta técnica se utiliza con el propdsito de
asegurar la precision temporal en la grabacion de eventos o sonidos, y especificamente, para
eliminar la diferencia de tiempo entre las grabadoras. La emision del pitido a dos metros se
convierte en una referencia auditiva comun para todas las grabadoras, lo que permite calcular
la variacion entre los relojes de las maquinas y luego garantiza que los datos registrados por
multiples microfonos estén alineados en el tiempo de manera coherente y sincronizada. Esta
sincronizacion es fundamental para el posterior analisis de datos y la interpretacion precisa de
los eventos sonoros registrados.

==

2m

Figura: Sincronizacion micréfonos



